Welcome to PDQ Inventory

PDQ Inventory features include:

PDQ Inventory is a systems management solution that allows IT administrators to + Scan computers for configuration
scan their network and collect hardware, software, and Windows configuration data. data.

PDQ Inventory maintains a database of your scanned computers, then organizes this + Group computers into Collections.
data into collections such as popular applications, Memory, Online Systems, and .

) ) i - Auto Sync with Active Directory.
Workstations. PDQ Inventory Collections make it easier to manage the computers

and the information most important to you. Each collection represents a set of " Runinventory reports.

computers and each computer can belong to multiple collections. Administrators *  Runremote commands on target
can also create their own dynamic or static collections and custom inventory reports. computers.
- Using PDQ Inventory, administrators can shut down or reboot machines remotely, + Use common admin tools: Event
boot offline machines using Wake-on-LAN, execute commands, run Remote Viewer, reboot, WOL, and others.
e I n Desktop, and other remote control tools on target computers. «  See which computers are online.
For details about licensing, see the “PDQ Inventory Licensing Mode Comparison” « Uninstall software.

S I l table on page 2.
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Licensing

PDQ Inventory offers the following
licensing modes:

+ Enterprise
+  Free

For details, see the licensing mode
comparison table on this page.

PDQ Inventory Enterprise licenses are
based on the number of system
administrators who use the software,
not the number of computers
managed. You need one license for
each administrator using PDQ
Inventory.

PDQ Inventory Enterprise and licenses
give users access to the software in
perpetuity.’ Each license also includes a
12-month subscription to the Collection
Library, product updates, and support.
To continue to use the Collection
Library, Tools Library, receive updates,
and support, users must maintain a
current subscription.

The following sections review some of
the benefits of maintaining a current
PDQ Inventory subscription.

Free product Upgrades

When using PDQ Inventory with a
current Enterprise level subscription, all
upgrades to PDQ Inventory are available
for free. You can set up auto update
checks in the Preferences menu or sign
up for email notifications.

(continues)

PDQ Inventory Licensing Mode Comparison

The following table describes and explains the PDQ Inventory licensing modes.

For all the details about licensing PDQ Inventory, see our End User License Agreement (EULA) at http://www.pdqg.com/aa/files/eula.pdf.

License Mode

Basics

Details

Enterprise The Enterprise mode license includes all of PDQ | License: The Enterprise license mode unlocks all of PDQ Inventory's features

Inventory's features.2 including automatic inventory scans, create custom reports, automatic Active
. . . Directory synchronization, collection and report sharing capability, scan caching,
Each Enterprise mode license is a perpetual sy ; 5 ) 'p & ) pability : &
: 1 up-to-date collections with the Collection Library, and various Tools in the Tools
license'However, access to product updates, ) ) . - .
; . . Library. Enterprise users also receive priority email support.

Collection Library updates, and support require
a current subscription.

Free The free mode allows unlimited use of a subset | License: No license or subscription is required. PDQ Inventory free mode is 100%

of PDQ Inventory features.?

PDQ Inventory can be used for free in
commercial and non-commercial environments.
There is no time limit, nor is there a limit to the
number of computers that can be managed.

free to use in any setting (commercial, government, or education). PDQ Inventory
can be redistributed so you may share the software; however, you may not
bundle PDQ Inventory inside other applications nor can it be rebranded or
decompiled.

Upgrade: You can upgrade3 a free installation of PDQ Inventory to Enterprise or
Pro modes at any time by purchasing a license key or by registering for an
Enterprise Trial4.

1. A perpetual license means that you can indefinitely use the license mode and version of PDQ Inventory you purchase and all the updates released during
the license period. However, to continue to receive support, product updates, and Collection Library updates, you must maintain a current subscription.

2. For the features available for each mode, see the PDQ Inventory Comparison table at https://www.pdg.com/compare/.

w

. For more information about upgrading, see Upgrading PDQ Inventory in Help or the PDQ Inventory Documentation.

4. The Enterprise Trial mode is a free, 14-day, fully functional Enterprise mode trial license. Sign up online at https://www.pdq.com/try/?inventory=1.
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Licensing (continued)

It is important to remember that
upgrade protection is valid only for
versions released within the
subscription period. Access to current
upgrades (including the Collection
Library and new tools in the Tools
Library) require that the product version
and subscription stay current.

A current Enterprise license key also
validates your subscription. If you have
ten Enterprise licenses, those licenses
must be associated with ten email
addresses on your Customer page. (To
activate your licenses login at https://
sales.pdg.com/CustomerLogon.) Each
console user must enter one of the ten
email addresses when activating their

Subscription Activation

When you launch PDQ Inventory, it uses
your license key to validate your
subscription, then gives you access to
the corresponding product features.

Product Requirements

Enterprise license.

The following table describes the system requirements and supported systems for PDQ Inventory.

System Requirements PDQ Inventory Console Target Computers

Operating Systems + Windows 10 (32-bit, 64-bit)

*  Windows 8.x (32-bit, 64-bit)

*  Windows 7 (32-bit, 64-bit)

*  Windows Vista SP2 (32-bit, 64-bit)

Windows Server 2016 (64-bit)
Windows Server 2012 R2 (64-bit)
Windows Server 2012 (64-bit)
Windows Server 2008 R2 (64-bit)
Windows Server 2008 (32-bit,64-bit)

Windows 10 (32-bit, 64-bit)
Windows 8.x (32-bit, 64-bit)
Windows 7 (32-bit, 64-bit)
Windows Vista SP2 (32-bit, 64-bit)

PDQ Inventory Product
Feature Comparison

PDQ Inventory can be used in three
license modes: Free, Pro, and
Enterprise. Each successive license level
includes all the benefits of the
preceding level plus additional features.

For details, see the PDQ Inventory
Comparison table on our web site at:

https://www.pdg.com/compare/

«  Windows Server 2016 (64-bit)

*  Windows Server 2012 R2 (64-bit)

*  Windows Server 2012 (64-bit)

*  Windows Server 2008 R2 (64-bit)

+ Windows Server 2008 (32-bit,64-bit)

Workstation: Windows 7 or 8.1
recommended.

« Server: Windows Server 2008 R2
or 2012 R2 recommended.

Configuration .

+ For less than 1000 computers,
8 GB RAM recommended.

+ For 1000+ computers, 64-bit
Windows with 16 GB RAM
recommended

Full Microsoft .NET Framework 4.5.2
(4.6 or higher recommended)

DNS Client service running (Required for
Windows remote communications)

Administrator account
(Domain account recommended)

1 GB RAM (2 GB recommended)

Microsoft .NET Framework 4.5.2
(4.6 or higher recommended)

Administrator account: Can be an Active
Directory domain account or local to the

target computer. A domain account is
recommended.

A well maintained DNS environment is
highly recommended.

Network Connectivity/Firewall

File and Printer Sharing must be
enabled.

+ Read/write access or higher is required
to the ADMIN$ share and service
manager.

Windows Firewall

+ Allow inbound file and printer sharing
exception. This rule allows the IPC$ and
ADMIN$ shares to be available.
Administrative access to these shares is
required.

+  Allow ICMP exceptions (Allow inbound
echo request). This rule allows a target
computer to respond to ping requests.’

1. For more information on firewall ports and exceptions, see the following page on our website at https://support.pdq.com/hc/en-us/articles/220533627.
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PDQ Inventory Installation

Installing PDQ Inventory

To install PDQ Inventory: 4 On the License Key window, select one of the following licensing options:

To install PDQ Inventory in Free mode or to install now and activate a license

1 Download the PDQ Inventory installer from our website:
later, select Use Free Mode, then click Next.

https://www.pdg.com/download/

2 Launch the installer (PDQInventory.x.x.x.x). B Initialize PDQ Inventory — O x

3 Onthe Welcome to PDQ Inventory window, click Next and follow prompts.
License Key

PDQ Inventory can run in Free, Pro or Enterprise moede. Free mode provides many of the
pragram's features for unlimited use. Pro and Enterprise modes unlock more features and can
be enabled at any time.

Get a free Tnial License for Enterprise Mode from our website.

®) Use Free Mode

“ nitislize PDQ Inventory == -

Welcome to PDQ Inventory

Thank you for installing PDQ Inventory. This wizard will gather information needed to get the
system up and running.

Use License (Pro or Enterprise)

Purchase License

0 Back Next Finish Cancel
[2) "“"il e Or, to install and activate PDQ Inventory now (you must have an Enterprise
license key):
4a On the License Key window, select Use License (Pro or Enterprise).
For details about upgrading and activating PDQ Inventory in Enterprise mode, The Enter License Key window opens.

see “License Key" in Help or the PDQ Inventory Documentation. .
4b Do one of the following:

+ Copy and paste your license key from the license email, then click OK.

Include --- START LICENSE ---and --- END LICENSE ---when
copying the key.
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+ Browse to and select your license key file, then click OK.

[ Enter License Key — O e
Paste key below or browse = Browse for License File

Include the '--- START LICENSE ---' and '--- END LICENSE ---' tags
when pasting

Cancel

« Onthe License Key window, click Next.
(Enterprise only) On the Enterprise Installation Type window, choose between a

Local or Central Server installation. For detailed information, see this article at:

https://support.pdq.com/hc/en-us/articles/115000257931.

On the Scanning Credentials window, type your User Name and Password.

1 PDQ Inventory Startup Configuration — m} x

‘P Scanning Credentials

PDQ Inventory requires administrator credentials to scan computers, the credentials must be an
administrator on this computer.

Domain DEADWOOD.LOCAL
User Name | studentl
Password SEEBHEBEREES

More information...

0 Back F'nishl}\? Cancel

PDQ Inventory requires administrator credentials that have administrator rights
on the console computer. You must also have administrative rights on the target
computers to copy files to the ADMIN$ share and to create and start the remote
service.

For more information about credentials, see “Credentials” and “Log on as a
Service Privilege” in Help or the PDQ Inventory Documentation.

For details about target computers and credentials, see Target Computers—
Configuration in the “Product Requirements” table on page 3.

7 Click Finish to complete the installation.

PDQ Inventory launches and automatically adds and scans the computer on
which it is installed. To get started with PDQ Inventory you must add computers
to the database. You can add computers by syncing with or browsing Active
Directory, doing a network discovery for an IP address range, or even typing
computer names manually. For an introduction to adding computers, see
“Adding Computers” on page 7.

PDQ Inventory is now installed and ready to scan and analyze workstations on your
network. However, before you get started, please review the following sections for
useful information on configuring and using PDQ Inventory.

Configuration/Troubleshooting

This section includes links to useful information and resources that will help you get
up to speed with PDQ Inventory.

+ If atarget computer is not a member of an Active Directory domain you may
need to enable Remote UAC. For instructions see the following article at:
https://support.pdq.com/hc/en-us/articles/220533007

* Thereis a wealth of configuration and troubleshooting information available in
our video library. Sample topics include:

+ Introduction to PDQ Inventory

+ TheTools Library in PDQ Inventory

+ Scheduling Scans in PDQ Inventory

For more information, see our PDQ Inventory videos and at:
https://support.pdq.com/hc/en-us/sections/204439227

+ For ongoing guidance, you can subscribe to our live weekly webcasts and ask us
questions directly at https://www.pdg.com/webcast/.
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Introduction to the Interface

This section introduces you to the main components of the PDQ Inventory
interface—the Main Console, Adding Computers, Collections, The Computer
Window, Creating Reports, and Tools.

The Main Console

The main console provides access to all of your computers, your configured The main console window is comprised of three navigational components—the
collections, reports, and tools. You can also access prebuilt collections with the Menu and Toolbar, the Tree, and the Page. The following sections provide more
Collection Library. information on these components.
Bl PDQ Inventory 15 Enterprise Mode - O >
Menu and File Edit View Collection Computer Report Tools Help
Toolbar -
Q ' il =1 e L—L\ e
by Add C ]_t- N Dg ic N 'St ti 6 D m] o
Se Tool ollecuon ew Lhynamic ew stanc . . N R rt
- Computers | Library Collection  Collection Rt W=D Era Copy Delete | Help
Cl All Computers @ View Computer Details T
Tree — ﬂ Welcome to PDQ Inventory ~ faglle i
| . - " 1 p 15 Versi . collection
Q All Computers (109) 1 i MName Online Scan Status Q/s 0/5 Version SP / Release Uptime members)
5 Auto Reports . @ PRICE ® Yes 7 6.1.7601 1 & days ~
Reports @ PROTOT ® Yes 10 10.0.10240.17190 16 days
Collection Library —— §li Collection Library €1 PrOTOZ © Yes 10 10.0.10240.17190 16 days
b 9B Aoplications @ PROTO3 ® Yes 10 10.0.10240.17236 16 days
bR Ldware @ PROTO4 ® Yes 10 10.0.10240.17236 16 days
, o8 o @ PUDDY ® Yes 7 6.1.7601 1 3 days
L ] d
P @ RAGNAR ® Yes 10 10.0.14393.693 1607 17 days
b % Runtimes
I @ 564-01 ® Yes 2008 £.0.6002 2 58 days
b T8 Windows Updates
) @) SCHMENDRICK @ Yes 7 6.1.7601 1 9 days
Tools Library — 4% Tools
Active Directory Collect o @ SHELDON ® Yes 8.1 £.3.9600 50 days
Ctive Director ollections — deadwood.l |
ve Birectory ' oy omee + @ sPocK O Ves 10 10.0.10240.17190 58 days
Prebuilt Dynamic Il o Allow Scan @ SRV15-01 ® Ves 2016 10.0.14393.321 1607 16 days
Collections b Intenet Explorer @ STITZER ® Yes 7 6.1.7601 1 8 days
L 1]
b= Te" Memory g suw ® Yes 10 10.0.14393.693 1607 6 days
b .5. Microsoft .NET Framework 4 £ SURFACE3 No 8.1 6.2.0600
+ % Microsoft Office @) SVEDKA ® Ves 10 10.0.10240.17236 15 days
= % Non-Standard Shares & SWEET18 ® Yes 2016 10.0.10586.404 1511 3 hours
Cusgg?;;:gﬁ ————— % Marketing computers " = E 5 -
109 Computers (1 selected) 0 Computers Scanning —_— Status bar
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Adding Computers

To get started using PDQ Inventory you must add your computers to the database so
they can be scanned and analyzed.

In Enterprise modes, you can add Active Directory (AD) computers automatically. On
the main console toolbar, click Add Computers > Active Directory - Sync (or
Options > Preferences > Active Directory), check Auto Sync Enabled, select the
AD Containers to include/exclude, then click Sync Now. Active Directory Sync is the
preferred method for adding computers with AD because it automatically syncs on
a schedule to capture future changes in AD.

NET Installation “ [V Create Active Directory Collections

Active Directo
2 Create Collections for Groups

Alerts

Database Active Directory Sync

Interface Auto Sync Enabled

Logging

Mail Server Sync Every 0[S]d 18] h 0 [8]|m

Network Delete Mode Mixed Sync (do not delete computers not part of sync) w
PDQ Deploy

Performance [] Sync Disabled Computers

Printing Last Sync 1/30/2017 12:52 PM

Proxy Server

Remote Contral Last Sync Status Success

Scanning Containers ™| Included | Container A User Subtree Include Container
Target Service + g DEADWOOD.LO... (default) DEADWC Exclude Container
§ DEADWOOD.LO... (default) DEADWC — + Edit

Delete

Sync Now [}

Computers can also be added manually through a variety of methods. Active
Directory - Browse By Name allows you to add individual computers from within
AD domains and containers. Network Discovery allows you to add computers with
an IP address or from a range of IP addresses (requires Enterprise mode). By Name
allows you to add computers by typing in computer names or importing a list of
computer names. To access these other methods of adding computers, click Add
Computers on the main console toolbar (or click Computer > Add Computers).

Once your computer names are resolved and added to the database, they are
immediately scanned for their hardware, software, and Windows configuration info.
PDQ Inventory uses this data to automatically populate the default collections and
Collection Library. (Enterprise mode required for use of the Collection Library.)

© 2018 PDQ.com Corporation. All Rights Reserved.
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Collections

PDQ Inventory uses collections to make it easier to manage the computers on your
network. A collection represents a set of computers with specific hardware, software,
or Windows configuration data. Collections can be populated automatically by
scanning and filtering computers for configuration data (dynamic collections) or
manually by adding/removing computers (static collections). Collections can be
nested below other collections in the tree. These subcollections retain independent
filters, unless the Drill down from parent collection option is selected (dynamic
collections only). A drill down collection becomes dependent upon the parent
collection by evaluating only the computers contained within the parent collection.

To view PDQ Inventory collections, on the Main Console window tree, select a
collection. The computers filtered by the selected collection appear on the page. The
following table describes the four types of PDQ Inventory collections:

Type Icon Description

All Computers [:] An automatic collection that contains all the computers added to your
local database through Active Directory, Network Discovery, or by Name.

Dynamic -e! Collections containing computers that match a set of collection filters.
| Computers in these collections are dynamically updated as inventory or

filters change.

Prebuilt Collections: Dynamic collections prebuilt in PDQ Inventory. For
example, Internet Explorer: Shows all computers with Explorer installed
and contains subcollections for several versions of Explorer.

Drill down from parent collection: Dynamic subcollections that
evaluate only the computers contained in the parent collection.

@@ | Collection Library: Dynamic collections that filter computers based on
popular applications and runtimes such as Java, Adobe Flash, and Google
Chrome. These collections are constantly updated and maintained by
PDQ.com (Enterprise mode required).

Static Collections populated manually by adding or removing computers.

Active Directory Collection automatically created after at least one Active Directory
computer is added. Based on the Active Directory preferences, members
of this collection can be automatically added or removed by PDQ
Inventory when changes are made in Active Directory. (Enterprise mode

required for automatic syncing).

3 =3

Active Directory Organizational Units (OUs): Collections populated by
members of your AD OUs.

Active Directory Security Groups: Collections populated by members of
your AD Security Groups (Enterprise Mode required).
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The Computer Window

The Computer window is a powerful resource that provides access to all inventory
data for a single computer. From the Computer window you can also start a scan,
launch admin tools including PDQ Deploy, and preview and print displayed data.

To open the Computer Window, double-click any computer on any collection page
(or select a computer, then click Computer > Open Computer or press Ctrl+0).

The Computer window is comprised of the following components—the Menu and
Toolbar, the List, the Page, and the Status bar. Each element of the computer's
inventory is included in the list on the left of the Computer window.

E!, SULU - Computer [75 of 110] — ] x
File Edit View Computer Tools Help

Q - = @)

23 Collections Mame SULU Parent Path Deadwood Computers
i CPU Description Description
= Custom Fields Host Name SULU.deadwood.local Domain deadwood.local
Added 2/2/2017 907 AM Domain Controller | Winston.deadwood.local
Deployments
Cnline & | Yes Location
£ Disk Drives Uptime 17 hours Last Logon 3/2/2017 1:55 AM
@ Displays Boot Time 3/1/2017 402 PM Created 12/15/2016 5:24 PM
c Environment Current User DEADWOODY System
M L Di
L] Files Eeplavibieans Manufacturer Gigabyte Technology Co., Ltd.
Hardware [P ek Madel To be filled by O.EM.
MAC Address
@ Hot Fixes _— TC.07000 - Memory 16 GB
& Local Groups ime £one 0700} Mountamlune Processor 4-Core 3.2 GHz Intel Core i5-65
Operating System Chassis Desktop
s Local Users K
v || O/S 10 Serial Number 071517

Sc'an T09|5 Prev Computer Next Computer Help
,. Computer @ SULU
L
Ei Active Directory Groups
[ Applications General Active Directory

Creating Reports

PDQ Inventory provides robust reporting tools that allow you to access your
computer inventory data using the reports built into PDQ Inventory. You can also
customize the built-in reports and create new reports using basic or SQL tools. You
can run the built-in reports and create new reports in Free mode, but Enterprise
mode is required to save changes.
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You can run reports against all computers in the system or a particular collection,
making it easier to include the exact data you want.

Reports can be viewed on screen, printed, and exported in a variety of formats. To
save a report, on the Report window click Print Preview (or click File > Print
Preview or press Ctrl+P), then click Export.

You can also create a new Dynamic Collections using the same filters from your
report by clicking the New Collection from Report button.

Auto reports are custom schedules you create that will run, save, or email any
available prebuilt or custom report (Enterprise mode required).

Tools and the Tools Library

PDQ Inventory Tools allow you to run admin tools remotely against individual
computers or groups of computers. These tools are built-in, external, from the Tools
Library, or even custom tools of your creation. The following table lists the built-in
admin tools (Enterprise mode required to add and use custom tools):

Page Icon Description

Event Viewer 6-3 Opens the event log on the target computer.

Manage with MMC /’ Opens the Microsoft Management Console.

Open ADMIN$ Share Opens the ADMIN$ share on the remote computer. Many remote

administration tools need to read or write to the ADMIN$ share.

PDQ Deploy Opens the Select PDQ Deploy Package window within PDQ Deploy
to initiate a deployment on the selected PDQ Inventory
computer(s) or collection(s).

Reboot/Shutdown (_') Opens the Reboot/Shutdown window.

Remote Assist % Opens the Windows Remote Assistance window.

Run Command F- Opens the Run Command window.

Remote Desktop [_. Opens the Windows Remote Desktop window.

VNC F_) Opens the VNC remote control viewer.

Wake @ Opens the Wake-On-LAN window.

To import tools from the Tools Library, modify and organize the Tools Menu, or create
your own custom tools, click Tools in the tree of the main console. To run a tool
against a computer, selected computer(s), click Tools on the main Toolbar, then
select the appropriate tool. (Enterprise mode required for the Tools Library.)
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Main Console Shortcuts

Menu and Toolbar Tree and Page Window
The tree contains all the default and custom collections, reports, custom report

folders, and Tools in your PDQ Inventory system.

The table below provides quick reference details for the most common menu and
toolbar commands. For the complete command quick reference table, see “Menu
and Toolbar” in Help or the PDQ Inventory Documentation.

Select an item in the tree to display its details in the page view on the right. You can
organize the tree by moving items around or creating custom folders for reports. The

Command Icon Shortcut Description . . . .
P following table provides a description for each element in the tree.
File Import D Ctrl+ Imports collection or report definitions.
Page Icon Description
Print Preview B Ctrl+P Prints what is displayed on the console.
) Welcome to PDQ a Includes links to get you started with PDQ Inventory, to
Edit Cut 3| ceriex Cuts the selected item. Inventory documentation resources, to Help, and to follow PDQ.com on
social networks.
Copy |:[\|—lj Ctrl+C Copies the selected item.
- All Computers Lists all computers added to your database.
Paste .D Ctrl+V Pastes the selected item.
= - Auto Reports Displays the list of auto reports. (Enterprise mode required.) Auto
Delete m |DPe Deletes the selected item. reports are schedules you create that will run, save, or email any
i . 29 ' . available prebuilt or custom report.
Collection | New Dynamic = Ctrl+N Create a new dynamic collection in the
Collection Dynamic Collection window. Reports Displays prebuilt reports (also default folder for custom reports).
New Static !!. Ctrl+Shift+N Create a new static collection in the Static Collection Library §lli | Displays sets of prebuilt collections for many popular applications
Collection Collection window. and runtimes. PDQ.com maintains and updates these collections
) constantly (Enterprise mode required).
Computer |Add Computers ! Select from the various methods of Y P q
adding computers. Dynamic Collection 88 | guilt-in Dynamic Collections in the Collection Library for popular
) =] o -
) (from Library) applications and runtimes such as Adobe Flash and Java.
Scan Computers q F6 Scans the selected computer(s) using a
(Default profile | pre-built or custom scan profile. Select Tools | Access the Tools Menu which allows you to create and organize the
only) from all available profiles. various tools as well as the Tools Library where you can import
™ . prebuilt tools.
Report New Report Create a new report using one of the
following: Basic, From Collection, or SQL. Active Directory m Displays collections that mirror the structure of your AD layout.
RUN R R buil Sel PDQ Inventory creates these collections when you scan an AD
un Report DS funs a”pre 'Ll“;lor custom report. select computer. Based on preferences, members of this collection can
rom all available reports. be automatically added or removed when changes are made in AD
Tools Tools % | Various Select from the various tools to be run (Enterprise mode required for AD Sync).
remotely agalrést the ;electe(cjj ired Dynamic Collections -e! Collections that are populated dynamically by collection filters.
computer(s). ( nterprlsg mode require (Default or Custom) | Select a collection to see its members on the collection page.
to create a tool, Enterprise mode
rgquired to import tools from the Tools Static Collections !!- Collections that are populated manually. Select a collection to see
Library) (Custom) its members on the collection page.
Options Preferences @ Ctrl+Comma Opens PDQ Inventory Preferences.
Help User Guide 0 F1 Opens the PDQ Inventory help window.
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Where Do | Go from Here?

Upgrade

To get the most out of PDQ Inventory, buy an Enterprise mode license.

« For a comparison of features, check out the PDQ Inventory Comparison table on
the Web at https://www.pdg.com/compare/.

+ For details about licensing, see “Licensing” on page 2.

+ To purchase PDQ Inventory licenses or generate a quote, see the page on our
web site at https://sales.pdg.com/.

Integrate with PDQ Deploy

PDQ Deploy complements PDQ Inventory. For example, in Enterprise mode, you can
view deployment data from PDQ Deploy in PDQ Inventory. You can use PDQ Deploy
to silently install almost any application or patch to multiple Windows computers
simultaneously. PDQ Deploy can use the data collected by PDQ Inventory to create
lists of computers that need specific applications or updates. You can also launch
PDQ Deploy from the PDQ Inventory Tools menu to directly initiate a deployment.
For more information about PDQ Deploy, see our web site at https://www.pdg.com/
pdg-deploy/. Also, see the video “Introduction to PDQ Deploy” at https://
support.pdg.com/hc/en-us/articles/220538907.

Create Custom Collections

With PDQ Inventory you can build your own custom collections to sort and organize
software and hardware data specific to the needs of your organization. You can
create static or dynamic collections and even create collections from reports. If you
want to build custom collections, see “Creating and Editing Collections” in Help or the
PDQ Inventory Documentation. Also, see the video “Collection Basics” at https://
support.pdg.com/hc/en-us/articles/220539607.

Build Custom Reports

In PDQ Inventory you can build custom reports using basic PDQ Inventory reporting
tools or SQL. You define the columns that appear and then configure the filters that
determine the data that the report captures. You can also define and create reports
from collections. To learn how to create reports, see “Designing Custom Reports” in
Help or the PDQ Inventory Documentation. Also, see the videos “Building Custom
Reports” at https://support.pdq.com/hc/en-us/articles/220539407 and “Building a
Report from a Collection” at https://support.pdq.com/hc/en-us/articles/220539347.

© 2018 PDQ.com Corporation. All Rights Reserved. PDQ Inventory Getting Started

Advanced Collections and Report Filters

PDQ Inventory provides powerful filtering functionality for defining collections and
reports. Using filtering effectively is the key to creating useful collections and reports.
For information about using collections and filtering, see the six-part video tutorial
series “Filters for Collections and Reports” starting with Part | at https://
support.pdq.com/hc/en-us/articles/220539867.

Shared Collections and Reports (Central Server)

Collections and reports can be shared manually by exporting from one console and
importing into another. You can also automatically share collections and reports with
other PDQ Inventory users in your organization using the Central Server. Central
Server requires that each console have an Enterprise User from the same license
with activated administrator accounts. For information about sharing, see “Central
Server Window” in Help or https://support.pdq.com/hc/en-us/articles/
115000257931. For more information, see the webcast “Introducing PDQ Inventory
13 (Central Server)” at https://support.pdg.com/hc/en-us/articles/115000494671.

Get Training
If you need product training, PDQ.com provides several options:

+  PDQ.com presents free weekly webcasts focused on one topic related to PDQ
Inventory. They are approximately 30 minutes long and include a Q&A session.
For information on upcoming live webcast topics, links to previous webcasts, and
to sign up for notifications, see our web site at https://www.pdq.com/webcast/.

+  We also have an extensive library of free training videos, available at anytime,
covering all aspects of setting up and using PDQ Inventory. Sample topics
include: adding custom data, creating reports from collections, sharing reports
and collections, integrating additional remote tools, and many others.

To browse the PDQ Inventory video library, see our web site at https://
support.pdg.com/hc/en-us/sections/204439227.

* You can also purchase Virtual Training (via phone and TeamViewer) for custom,
one-on-one training from a PDQ Inventory instructor for your company. To
request more information, see our web site at https://www.pdqg.com/request-
private-web-training/.
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